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C H A P T E R 1

What’s New in Guardian 1.1

The following sections describe new and changed functionality in Guardian 1.1. Topics include:

New Data Collectors

Import/Export Workspace

Signature Annotations

Snapshot Evaluations

Compare Inventories or Evaluations

Export Inventories and Evaluations as PDF or HTML,

Domain Groups

Improved Agent Performance in Large Domains

Validate and Test Proxy Configuration from Preference Page

Customize Report Displays

Improved Error Reporting and Logging

Release Localized Versions as Language Packs

The following sections provide a description of each of these new features.
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New Data Collectors
The scope of Guardian 1.1 is greatly extended by the addition of the following new Data 
Collectors:

J2EE Deployment Descriptors Collector

JRockit Runtime Analyzer Collector

JRockit Collector

JRockit Thread Dump Collector

A description of each is provided in the following sections.

J2EE Deployment Descriptors Collector
The J2EE Deployment Descriptors Collector gathers the J2EE deployment descriptors from the 
WebLogic instances. Deployment descriptors contain information that informs the Application 
Server about elements contained within a deployment, and what server resources a deployment 
relies upon. This greatly extends the scope of Guardian, as signatures can now be designed to 
focus on the configuration of your specific managed application. This is in addition to the server 
resources of which Guardian is already aware. 

JRockit Runtime Analyzer Collector
The JRockit Runtime Analyzer (JRA) Collector initiates a JRA recording in each of the servers 
in the target domain under evaluation, and returns the results for signature evaluation. See the 
JRockit Runtime Analyzer documentation for more information.

JRockit Collector 
The JRockit Collector gathers data from each of the servers in the target domain using the JRockit 
Management API , and returns the results for signature evaluation. For more information, see the 
BEA JRockit JMAPI documentation.

JRockit Thread Dump Collector 
The JRockit Thread Dump Collector takes a thread dump from each of the servers in the target 
domain using the JRockit Management API and returns the results for signature evaluation.
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Import/Export Workspace
You can now export your Guardian Workspace data to a file, which you can use for backup and 
recovery purposes, or to import to another Guardian instance. You can now also import a 
Guardian Workspace from another Guardian instance, or an exported Workspace data file.

Note: To prevent loss of work when Guardian is updated or uninstalled, make sure your 
Workspace and any Workspace export files are located outside of your Guardian 
Installation directory. 

Signature Annotations
Signature Annotations enable you to tag a detected signature with one or more persistent 
annotations about that signature. 

An annotation contains the following information:

Type — This indicates the Annotation Type. There are two types: Ignore and Flag. 

Name — (Optional) This is a text field into which you can enter a short name for this 
annotation.

Comment — This is a text field into which you can enter comments or other notes about 
the signature. 

Timestamp — This records the date and time the annotation was created.

Domains — This specifies the Annotation Target for this annotation for this signature. 
This can be All Domains, This Domain, or This Evaluation. 

Evaluations — (Automatic) This specifies the Evaluation(s) to which this annotation 
applies for this signature.

You can use the Annotations Wizard to create, edit, and delete annotations. In addition, you can 
use Signature Filters to specify which annotated signatures are to be displayed in the Signature 
Explorer, Bundle Explorer, and Evaluation Summaries. 

Note: Signatures with annotations set to Ignore with a filter of Hide are not displayed in 
signature lists, but are still counted as detected signatures. You can include them again in 
displays by changing the filter setting for Annotation Type Ignore to Show.
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Snapshot Evaluations
A Snapshot Evaluation is a complete assessment of all of the configuration details for a specific 
domain, at the particular moment the evaluation is executed. The process for performing a 
Snapshot Evaluation is the same as for any other type of evaluation. The primary difference is in 
the type of Signature Bundle you select for the evaluation, and the type of information the 
evaluation collects and evaluates. 

There are several types of Snapshot Evaluations. These are as follows:

Snapshot - All — Includes all available configuration and runtime data from all of the 
servers in the target domain. This snapshot may take longer in large domains.

Snapshot - JDBC — Includes all JDBC-related data from all of the servers in the target 
domain.

Snapshot - JMS — Includes all JMS-related MBean data from all of the servers in the 
target domain.

Snapshot - Security — Includes all security-related MBean data from all of the servers in 
the target domain.

Compare Inventories or Evaluations
You can now compare inventories or evaluations from the same or different domains. Both 
objects must be of the same type—that is, two inventories or two evaluations. You cannot 
compare an inventory against an evaluation. 

You can compare any two Evaluation Summaries. Comparing two Snapshot Evaluations is 
particularly useful, as a Snapshot Evaluation collects and evaluates all of the configuration data 
for the evaluated domain. Such a comparison enables you to see very quickly the differences 
between the configurations and their issues for those two domains.

Export Inventories and Evaluations as PDF or HTML, 
You can now export a Domain Inventory or Evaluation Summary report to a PDF or HTML file 
for external viewing, processing, or archiving. 

To export a report, open the Domain Explorerand then open the History folder containing the 
report you want to save. Open the report and then select File > Save As. Browse to the location 
to save the file, select the file type (PDF or HTML), and click OK.
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Domain Groups
You can now organize the domains in Guardian into Domain Groups for easier management. You 
can create a Domain Group in the Domain Explorer, by right-clicking on Target Domains and 
selecting Add Domain Group from the context menu. This opens the Add Domain Group 
dialog box for creating the new Domain Group. A domain node folder for the Domain Group is 
added to the Domain Explorer Domain Tree. You can then populate the Domain Group by 
simply dragging and droping domains into the Domain Group folder. 

Improved Agent Performance in Large Domains
To improve performance in large domains, multiple Agent threads have been implemented in 
Guardian 1.1.

When Guardian requests data from a target domain, the Guardian Agent on the WebLogic 
Administration Server collects the requested data from each of the Managed Servers. In Guardian 
1.0, this happens serially; that is, the Agent requests the data from each Managed Server and waits 
for the response before requesting the data from the next Managed Server. This can result in slow 
activations and evaluations of large domains. 

In Guardian 1.1, the Agent running in the Administration Server now spawns one thread per 
Managed Server, up to the value specified for the Maximum Agent Threads Parameter, to collect 
evaluation data. Each of these threads runs no longer than the value specfied for Agent Thread 
Timeout Parameter.

Details about these parameters are provided in the following sections.

Maximum Agent Threads Parameter
If you have one or more managed servers in a domain, the Guardian Agent spawns the appropriate 
number of threads for communicating between the Guardian Agent on the WebLogic 
Administration Server, and the Guardian Agent running on the Managed Server(s). However, an 
excessive number of threads can affect the performance of the Administration Server. To control 
this, you can specify the maximum number of Agent threads to allocate to the WebLogic Server 
Administration Server for a specified domain. The Max. Agent Threads parameter setting 
determines this value. The default is 10. 
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There are two ways to set the value for this parameter:

When activating the domain, you can set the Max. Agent Threads parameter in the 
Advanced tab page of the Domain Activation Wizard.

If the domain is already activated, you can set the Max. Agent Threads parameter in the 
Domain Properties dialog box.

Agent Thread Timeout Parameter
In order to manage Agent resources on both the WebLogic Administration Server and Managed 
Servers, Guardian enables you to specify the maximum amount of time (in seconds) that can 
elapse before a thread is terminated. The Agent Thread Timeout parameter governs this 
timeout. The default is 60 seconds. 

There are two ways to set the Agent Thread Timeout parameter:

When activating the domain, you can set the Agent Thread Timeout parameter in the 
Advanced tab page of the Domain Activation Wizard.

If the domain is already activated, you can set the Agent Thread Timeout parameter in 
the Domain Properties dialog box.

Validate and Test Proxy Configuration from Preference 
Page

If you are using an outbound proxy server for communications between Guardian and the outside 
world, you can now test and validate the outbound proxy connection. This simplifies proxy 
troubleshooting, and enhances supportability. 

To test an outbound proxy server connection, select Window > Preferences from the Guardian 
titlebar menu to go to the Preferences configuration page. Then, open the Guardian folder and 
select BEA Support. Select the Requires Proxy checkbox and click Test Proxy to initiate the 
test. After the test completes, a status message is displayed at the top of the page as to whether it 
was successful or not.
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Customize Report Displays
You can now select the Theme to be used for Report displays. 

To select a Report Theme, do the following:

1. Select Window > Preferences to open the Preferences configuration page.

2. Open the General folder and select Appearance.

You do not need to open the Appearance folder.

3. For Current Theme, select a Theme from the drop down menu.

4. Click OK.

Improved Error Reporting and Logging
Guardian logging and debugging now employs aspect-oriented techniques, which allow you to 
dynamically enable and disable different levels and scopes of debugging. You can configure 
these parameters in the Logging and Debug section of the Preferences configuration page. 

The following section provides instructions for configuring your Logging and Debug 
preferences.

Configuring Logging and Debug Preferences
To configure these preferences, do the following:

1. Select Window > Preferences to open the Preferences configuration page.

2. In the Preferences tree, open the Guardian folder and select Logging and Debug.

This displays the Logging and Debug preferences pane. The preferences are organized 
into four sections:

– Logging and Exceptions

– Scenario Tracing 

– Pinpoint Tracing

– Server Agent Debugging
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3. Select your Logging and Debug preferences.

4. Click Apply.

5. Click OK to dismiss the Preferences page.

Release Localized Versions as Language Packs
Guardian 1.1 now uses Language Packs for release of localized versions. Guardian is currently 
in the process of being localized, and Language Packs will be available soon.



BEA Guardian 1.1.0 Release Notes 2-9

C H A P T E R 2

Known and Resolved Issues in 
Guardian 1.1

This chapter describes known problems in Guardian 1.1 as well as issues found in earlier versions 
that are now resolved in version 1.1. Entries include a description of the problem, and a 
workaround or solution where appropriate. 

Known Issues

Changes and Resolved Issues for Guardian 1.1

Special Notes

– Upgrading from Guardian 1.0.x to Guardian 1.1

– Preserving Credentials When Using Guardian Headless Mode

For instructions on installing Guardian 1.1, see the Guardian 1.1 Installation Guide.

For additional information about the new features and capabilities of Guardian 1.1, see “What’s 
New in Guardian 1.1” on page 1.
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Known Issues
The following table describes issues in Guardian 1.1. Entries include a description of the issue, 
and a workaround or solution where appropriate.

Table 2-1  Known Issues in Guardian 1.1

Tracking Number Description and Workaround

CR329398 Agent returns resources that have been removed from the domain. 
This is a WebLogic Server issue.

CR355781 Password is passed in clear text between client and Agent if using 
HTTP.

Workaround: Use HTTPS if you want the password to be 
encrypted.

CR366182 Compare is showing differences in the inventory when JDBC 
resources are sorted in a different order.

CR365881 Annotations are not exported/imported with workspace.

CR363086 Right-clicking on a domain inside a Domain Group and selecting 
“Evaluate” from the context menu does not work.
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Changes and Resolved Issues for Guardian 1.1
The following table describes changes and issues that were found in earlier versions of Guardian 
that are resolved in Guardian 1.1.

CR364789 Cannot create a case from a signature that has no recommended 
attachments.

CR365521 Evaluate does not work properly when upgrading from one 
WebLogic Server version to another. 

Workaround: In a given workspace, if the server version is 
changed but the Domain Name, Admin Host Name, and Admin Port 
remain the same, you must deactivate the domain and then reactivate 
it for a successful evaluation. Do the following:
1. Install WebLogic Server 9.2.
2. Activate and evaluate the domain.
3. Uninstall WebLogic Server 9.2 and install WebLogic Server 10 

with the same Domain Name, Admin Host Name and Admin 
Port.

4. Deactivate the domain.
5. Reactivate the domain.
6. Rerun the evaluation, which should now succeed.

Table 2-1  Known Issues in Guardian 1.1

Tracking Number Description and Workaround

Table 2-2  Changes and Resolved Issues for Guardian 1.1

Change Request Number Description

CR304037 Fixed error message that displays when an operation is cancelled.

CR286954 Added feature for changing the logging level from UI.

CR316173 Internationalized bundle descriptions.

CR304767 Updated Headless command usage information to document -c flag 
for persisting credentials.

CR314072 Added version and build information to log file.
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CR282932 Fixed issue caused by deleting guardian.dat file from the 
configuration directory.

CR300460 Reduced the number of the weblogic classes we repackage, cutting 
Guardian installer size by 14% from 1.0.7 installer.

CR303636 Fixed inconsistent icon in Support Case Wizard Progress View.

CR303591 Fixed Domain Deactivation Success dialog to mention all of the 
domains deactivated if multiple were selected.

CR355818
CR356606
CR327502

Fixed NullPointerException and XmlException when 
opening some evaluations in GUI.

CR308897 Improved error messages for license issues.

CR314616 Merged BEA Support and Eclipse Install/Update proxy settings.

CR303831 Fixed error on data upload after update.

CR358410 Improved Domain Activation error messages.

CR362720 Improved error messages for activation/evaluation/inventory 
deployment scenarios.

CR300289 Added balloon description to Signature Explorer.

CR321532 Added feature for saving artifact as HTML or PDF.

CR351436 Added Patch ID and Passcode to remedy display.

CR329562 Suppress Mbean attributes which are clear-text passwords.

CR295478 Fixed issue with truncated text fields in Linux GUI.

Table 2-2  Changes and Resolved Issues for Guardian 1.1

Change Request Number Description
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Special Notes

Upgrading from Guardian 1.0.x to Guardian 1.1
If you are upgrading from Guardian 1.0.x to Guardian 1.1, there are some additional requirements 
to complete the upgrade procedure:

1. Install Guardian 1.1: You must install Guardian 1.1 in a different location than the previous 
Guardian 1.0.x installation. Otherwise, the Registry will not be installed properly and 
Guardian will not be able to start. 

2. Download and install the Upgrade Plugin: After installing Guardian 1.1., you must then 
download and install the Upgrade Plug-in to complete the upgrade procedure. The Upgrade 
Plug-in copies a Guardian 1.0 Workspace into your current Guardian 1.1 Workspace, and 
updates the Guardian 1.1 Registry. To download the Upgrade Plug-in, go to the following 
URL:

http://dev2dev.bea.com/blog/iang/archive/2008/03/importing_your.html

Download the following file:

com.bea.guardian.ui.importing_1.0.0.jar

3. Import your Guardian 1.0 Workspace into Guardian 1.1: The final step is to start the 
Guardian 1.1. User Interface and use the Import Wizard to import your Guardian 1.0 
Workspace into Guardian 1.1. 

Note: For basic instructions for completing these tasks, see “Upgrade Instructions” on page 13, 
below. For complete instructions and additional important information, see the BEA 
Guardian 1.1 Installation Guide.

Upgrade Instructions
This section provides basic instructions for upgrading to Guardian 1.1. For complete instructions 
and additional important information, see the BEA Guardian 1.1 Installation Guide.

To upgrade from Guardian 1.0.x to Guardian 1.1:

1. Install Guardian 1.1 in a location separate from your Guardian 1.0.x installation.

Caution: If you are upgrading from Guardian 1.0.x to Guardian 1.1, do not accept the 
default installation location. Be sure to install Guardian 1.1 in a different location 
than the previous Guardian 1.0.x installation.
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2. Download the Guardian 1.1 Upgrade Plug-in.

a. Go to the following URL:
http://dev2dev.bea.com/blog/iang/archive/2008/03/importing_your.html

b. Download the following file:
com.bea.guardian.ui.importing_1.0.0.jar

3. Start the Guardian 1.1 User Interface.

Guardian first displays the initial Welcome screen while loading, and then displays the 
Select Workspace dialog box.

4. Click Browse to open a browser to select or create your Guardian 1.1 Workspace folder.

IMPORTANT: For this upgrade procedure, do not accept the default location. Also, make 
sure the Workspace is not located within the Guardian installation directory, and is in a 
different location than your original Guardian 1.0.x Workspace. You may also want to 
select the 

5. Click OK to select the folder and return to the Select Workspace page.

6. (Optional) Select Use this as the default workspace and do not ask again. 

For the purposes of this upgrade, it is recommended that you select this option until the 
upgrade is complete. You can change this setting at a later time by selecting Prompt for 
workspace on startup in the Guardian Preferences configuration page.

7. Click Finish to create the new Workspace and start Guardian.

8. Import your Guardian 1.0 Workspace.

a. Select File > Import to open the Import wizard.

b. In the folder tree, open the Guardian folder and select Guardian 1.0 Workspace. 

c. Click Next to proceed to the Select 1.0 Installation page.

d. Click Browse to open a file browser and select your Guardian 1.0 installation directory.

e. Select the directory and click OK.
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f. Click Next to proceed to the Select 1.0 Workspaces page.

g. Selecte a Workspace and click Finish.

Guardian proceeds to import the selected 1.0 Workspace. This may take a few seconds to 
complete.

9. Restart Guardian.

Restart Guardian to automatically add the domains from the imported Workspace to the 
Domain Explorer tree. Until you restart Guardian, the imported data will not be displayed 
in the Navigation Pane Explorers.

The installation is now complete, and you can use Guardian 1.1 to evaluate your environment.

Preserving Credentials When Using Guardian Headless 
Mode
You must use the –c true flag with Headless Mode evaluate commands or the credentials will 
be removed.

Examples:

Guardianheadless –g activateDomain –t http://localhost:7001 –u user –p 
password –c true

The above example activates a domain and saves the credentials.

Guardianheadless –g evaluateDomainBundle –d domainName –c true

The above example evaluates a domain and retains the credentials.

Guardianheadless –g evaluateDomainBundle –d domainName

The above example evaluates a domain and removes the credentials. 

Once the credentials are removed, you must pass them in again using the –u and –p options with 
the –c true flag set.
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A P P E N D I X A

Appendix A: Apache License

Apache License
The following applies to all products licensed under the Apache 2.0 License. You may not use 
the identified files except in compliance with the Apache License, Version 2.0 (the "License"). 
You may obtain a copy of the License at: http://www.apache.org/licenses/LICENSE-2.0. A copy 
of the license is also reproduced below. Unless required by applicable law or agreed to in writing, 
software distributed under the License is distributed on an "AS IS" BASIS, WITHOUT 
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License 
for the specific language governing permissions and limitations under the License. 

Apache License 
Version 2.0, January 2004 

http://www.apache.org/licenses/ 

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION 

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined 
by Sections 1 through 9 of this document. 

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is 
granting the License. 
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"Legal Entity" shall mean the union of the acting entity and all other entities that control, are 
controlled by, or are under common control with that entity. For the purposes of this definition, 
"control" means (i) the power, direct or indirect, to cause the direction or management of such 
entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the 
outstanding shares, or (iii) beneficial ownership of such entity. 

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by 
this License. 

"Source" form shall mean the preferred form for making modifications, including but not limited 
to software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a 
Source form, including but not limited to compiled object code, generated documentation, and 
conversions to other media types. 

"Work" shall mean the work of authorship, whether in Source or Object form, made available 
under the License, as indicated by a copyright notice that is included in or attached to the work 
(an example is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or 
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other 
modifications represent, as a whole, an original work of authorship. For the purposes of this 
License, Derivative Works shall not include works that remain separable from, or merely link (or 
bind by name) to the interfaces of, the Work and Derivative Works thereof. 

"Contribution" shall mean any work of authorship, including the original version of the Work and 
any modifications or additions to that Work or Derivative Works thereof, that is intentionally 
submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or 
Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this 
definition, "submitted" means any form of electronic, verbal, or written communication sent to 
the Licensor or its representatives, including but not limited to communication on electronic 
mailing lists, source code control systems, and issue tracking systems that are managed by, or on 
behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding 
communication that is conspicuously marked or otherwise designated in writing by the copyright 
owner as "Not a Contribution." 

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a 
Contribution has been received by Licensor and subsequently incorporated within the Work. 

2. Grant of Copyright License.  Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, 
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publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or 
Object form. 

3. Grant of Patent License.  Subject to the terms and conditions of this License, each 
Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, 
irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, 
sell, import, and otherwise transfer the Work, where such license applies only to those patent 
claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone 
or by combination of their Contribution(s) with the Work to which such Contribution(s) was 
submitted. If You institute patent litigation against any entity (including a cross-claim or 
counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work 
constitutes direct or contributory patent infringement, then any patent licenses granted to You 
under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works 
thereof in any medium, with or without modifications, and in Source or Object form, provided 
that You meet the following conditions: 

(a) You must give any other recipients of the Work or Derivative Works a copy of this License; 
and 

(b) You must cause any modified files to carry prominent notices stating that You changed the 
files; and (

c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, 
patent, trademark, and attribution notices from the Source form of the Work, excluding those 
notices that do not pertain to any part of the Derivative Works; and 

(d) If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative 
Works that You distribute must include a readable copy of the attribution notices contained 
within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative 
Works, in at least one of the following places: within a NOTICE text file distributed as part of the 
Derivative Works; within the Source form or documentation, if provided along with the 
Derivative Works; or, within a display generated by the Derivative Works, if and wherever such 
third-party notices normally appear. The contents of the NOTICE file are for informational 
purposes only and do not modify the License. 

You may add Your own attribution notices within Derivative Works that You distribute, 
alongside or as an addendum to the NOTICE text from the Work, provided that such additional 
attribution notices cannot be construed as modifying the License. You may add Your own 
copyright statement to Your modifications and may provide additional or different license terms 
and conditions for use, reproduction, or distribution of Your modifications, or for any such 
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Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work 
otherwise complies with the conditions stated in this License. 

5.Submission of Contributions.  Unless You explicitly state otherwise, any Contribution 
intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms 
and conditions of this License, without any additional terms or conditions. Notwithstanding the 
above, nothing herein shall supersede or modify the terms of any separate license agreement you 
may have executed with Licensor regarding such Contributions. 

6. Trademarks.  This License does not grant permission to use the trade names, trademarks, 
service marks, or product names of the Licensor, except as required for reasonable and customary 
use in describing the origin of the Work and reproducing the content of the NOTICE file. 

7. Disclaimer of Warranty.  Unless required by applicable law or agreed to in writing, Licensor 
provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, 
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, 
including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, 
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely 
responsible for determining the appropriateness of using or redistributing the Work and assume 
any risks associated with Your exercise of permissions under this License. 

8. Limitation of Liability.  In no event and under no legal theory, whether in tort (including 
negligence), contract, or otherwise, unless required by applicable law (such as deliberate and 
grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, 
including any direct, indirect, special, incidental, or consequential damages of any character 
arising as a result of this License or out of the use or inability to use the Work (including but not 
limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any 
and all other commercial damages or losses), even if such Contributor has been advised of the 
possibility of such damages. 

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative 
Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, 
indemnity, or other liability obligations and/or rights consistent with this License. However, in 
accepting such obligations, You may act only on Your own behalf and on Your sole 
responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, 
and hold each Contributor harmless for any liability incurred by, or claims asserted against, such 
Contributor by reason of your accepting any such warranty or additional liability. 

END OF TERMS AND CONDITIONS 

APPENDIX: How to apply the Apache License to your work
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To apply the Apache License to your work, attach the following boilerplate notice, with the fields 
enclosed by brackets "[]" replaced with your own identifying information. (Don't include the 
brackets!) The text should be enclosed in the appropriate comment syntax for the file format. We 
also recommend that a file or class name and description of purpose be included on the same 
"printed page" as the copyright notice for easier identification within third-party archives.

Copyright 2008 [name of copyright owner] Licensed under the Apache License, 

Version 2.0 (the "License"); you may not use this file except in compliance 

with the License. You may obtain a copy of the License at 

http://www.apache.org/licenses/LICENSE-2.0. Unless required by applicable 

law or agreed to in writing, software distributed under the License is 

distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY 

KIND, either express or implied. See the License for the specific language 

governing permissions and limitations under the License.



Append ix  A :  Apache  L icense

A-22 BEA Guardian 1.1.0 Release Notes



BEA Guardian 1.1.0 Release Notes B-23

A P P E N D I X B

Appendix B: Eclipse License

Eclipse Foundation Software User Agreement
March 17, 2005

Usage Of Content
THE ECLIPSE FOUNDATION MAKES AVAILABLE SOFTWARE, DOCUMENTATION, 
INFORMATION AND/OR OTHER MATERIALS FOR OPEN SOURCE PROJECTS 
(COLLECTIVELY "CONTENT"). USE OF THE CONTENT IS GOVERNED BY THE 
TERMS AND CONDITIONS OF THIS AGREEMENT AND/OR THE TERMS AND 
CONDITIONS OF LICENSE AGREEMENTS OR NOTICES INDICATED OR 
REFERENCED BELOW. BY USING THE CONTENT, YOU AGREE THAT YOUR USE OF 
THE CONTENT IS GOVERNED BY THIS AGREEMENT AND/OR THE TERMS AND 
CONDITIONS OF ANY APPLICABLE LICENSE AGREEMENTS OR NOTICES 
INDICATED OR REFERENCED BELOW. IF YOU DO NOT AGREE TO THE TERMS AND 
CONDITIONS OF THIS AGREEMENT AND THE TERMS AND CONDITIONS OF ANY 
APPLICABLE LICENSE AGREEMENTS OR NOTICES INDICATED OR REFERENCED 
BELOW, THEN YOU MAY NOT USE THE CONTENT.

Applicable Licenses
Unless otherwise indicated, all Content made available by the Eclipse Foundation is provided to 
you under the terms and conditions of the Eclipse Public License Version 1.0 ("EPL"). A copy of 
the EPL is provided with this Content and is also available at 



Append ix  B :  Ec l ipse  L icense

B-24 BEA Guardian 1.1.0 Release Notes

http://www.eclipse.org/legal/epl-v10.html. For purposes of the EPL, "Program" will mean the 
Content.

Content includes, but is not limited to, source code, object code, documentation and other files 
maintained in the Eclipse.org CVS repository ("Repository") in CVS modules ("Modules") and 
made available as downloadable archives ("Downloads").

Content may be structured and packaged into modules to facilitate delivering, extending, 
and upgrading the Content. Typical modules may include plug-ins ("Plug-ins"), plug-in 
fragments ("Fragments"), and features ("Features").

Each Plug-in or Fragment may be packaged as a sub-directory or JAR (Java™ ARchive) in 
a directory named "plugins".

A Feature is a bundle of one or more Plug-ins and/or Fragments and associated material. 
Each Feature may be packaged as a sub-directory in a directory named "features". Within a 
Feature, files named "feature.xml" may contain a list of the names and version numbers of 
the Plug-ins and/or Fragments associated with that Feature.

Features may also include other Features ("Included Features"). Within a Feature, files 
named "feature.xml" may contain a list of the names and version numbers of Included 
Features.

The terms and conditions governing Plug-ins and Fragments should be contained in files named 
"about.html" ("Abouts"). The terms and conditions governing Features and Included Features 
should be contained in files named "license.html" ( "Feature Licenses"). Abouts and Feature 
Licenses may be located in any directory of a Download or Module including, but not limited to 
the following locations:

The top-level (root) directory

Plug-in and Fragment directories

Inside Plug-ins and Fragments packaged as JARs

Sub-directories of the directory named "src" of certain Plug-ins

Feature directories

Note: If a Feature made available by the Eclipse Foundation is installed using the Eclipse 
Update Manager, you must agree to a license ("Feature Update License") during the 
installation process. If the Feature contains Included Features, the Feature Update 
License should either provide you with the terms and conditions governing the Included 
Features or inform you where you can locate them. Feature Update Licenses may be 
found in the "license" property of files named "feature.properties" found within a 
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Feature. Such Abouts, Feature Licenses, and Feature Update Licenses contain the terms 
and conditions (or references to such terms and conditions) that govern your use of the 
associated Content in that directory.

THE ABOUTS, FEATURE LICENSES, AND FEATURE UPDATE LICENSES MAY REFER 
TO THE EPL OR OTHER LICENSE AGREEMENTS, NOTICES OR TERMS AND 
CONDITIONS. SOME OF THESE OTHER LICENSE AGREEMENTS MAY INCLUDE 
(BUT ARE NOT LIMITED TO):

Common Public License Version 1.0 
(available at http://www.eclipse.org/legal/cpl-v10.html)

Apache Software License 1.1 
(available at http://www.apache.org/licenses/LICENSE)

Apache Software License 2.0 
(available at http://www.apache.org/licenses/LICENSE-2.0)

IBM Public License 1.0 
(available at http://oss.software.ibm.com/developerworks/opensource/license10.html)

Metro Link Public License 1.00 
(available at http://www.opengroup.org/openmotif/supporters/metrolink/license.html)

Mozilla Public License Version 1.1 
(available at http://www.mozilla.org/MPL/MPL-1.1.html)

IT IS YOUR OBLIGATION TO READ AND ACCEPT ALL SUCH TERMS AND 
CONDITIONS PRIOR TO USE OF THE CONTENT. If no About, Feature License, or Feature 
Update License is provided, please contact the Eclipse Foundation to determine what terms and 
conditions govern that particular Content.

Cryptography
Content may contain encryption software. The country in which you are currently may have 
restrictions on the import, possession, and use, and/or re-export to another country, of encryption 
software. BEFORE using any encryption software, please check the country’s laws, regulations 
and policies concerning the import, possession, or use, and re-export of encryption software, to 
see if this is permitted.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both. 
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